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In This Guide…
Agilent G2565CA Microarray Scanne
This user guide contains instructions to get started with, use, 
troubleshoot, and maintain your Agilent Microarray Scanner 
System.
1 
Introduction 

This chapter describes the Microarray Scanner and preparation 
for its operation.
2
 Getting Started

In this chapter, learn how to safely operate the Microarray 
Scanner and learn how to set up and then scan slides with the 
Agilent Scan Control program.
3
 Changing Scan Settings

Learn what the scan settings do and when and how to change 
them.
4
 Using Tools 

In this chapter, learn how to set up profiles — groups of scan 
settings — scan regions and laser auto On/Off times.
5
 Maintaining and Troubleshooting Your System

This chapter describes maintenance procedures and tips, as 
well as error messages for troubleshooting your system. 
6
 Reference

This chapter presents slide specifications and regulatory 
compliance information.
r System (Scan Control Software 8.4) User Guide 3
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Agilent G2565CA Microarray Scanner System
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1
Introduction

A powerful tool for microarray analysis    10

System description    11

Principles of operation    17

This chapter provides a general introduction to the
Agilent G2565CA Microarray Scanner System. 
A powerful 
tool...
This section describes the features that make the microarray 
scanner a powerful tool for Agilent’s microarray analysis 
solution. 
System 
description
In this section learn about the hardware and software features 
of the microarray scanner, the parts and system requirements, 
the site preparation information and the safety guidelines. 
Principles of 
operation
This section explains how the microarray scanner works. 
9Agilent Technologies



1 Introduction


A powerful tool for microarray analysis
10 Agilent G25
The Agilent G2565CA Microarray Scanner is part of the 
microarray analysis solution from Agilent Technologies. The 
microarray scanner is a sophisticated laser- induced 
fluorescence scanner designed to read microarrays printed on 
standard 1 in  3 in slides. 

The microarray scanner measures the fluorescence intensity of 
labeled sample nucleic acid (DNA and RNA) bound to 
microarrays. Its ability to measure fluorescence from two dyes 
simultaneously facilitates all two- color microarray studies. This 
technology provides for rapid, high- quality, automated scanning 
of microarrays.

Figure 1 Agilent G2565CA Microarray Scanner

Each slide is scanned in minutes, and the files are prepared for 
feature extraction analysis. 
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide
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Hardware and software features
System description
Agilent G2565CA Microarray Scanne
In this section you find listings of hardware and software 
features, parts, and computer requirements, as well as a 
physical description of the scanner and information on site 
preparation and safety.
Hardware and software features

The microarray scanner provides the following features: 

• Internal and external barcode reading 

• Dynamic auto- focus 

• Automatic PMT gain calibration prior to each scan

• Continuous laser power stabilization

• 2- , 3- , 5-  or 10- micron pixel size 

• Dynamic range of >104 for a single scan in 16- bit scan mode, 
>105 for a single scan in 20- bit scan mode, and >106 for a dual 
scan in 16- bit scan mode (XDR)

• TIFF image file compression

• Uniformity specification of <5% CV (Coefficient of Variation)

The Scan Control software allows you to select the dye 
(fluorescence) channels, scan regions, resolution, dynamic 
range, PMT gain and output folders for each of the slides in the 
carousel run. These settings can be automatically loaded from 
saved application- specific profiles, or can be individually 
selected.
Parts list

The Agilent G2565CA Microarray Scanner System consists of 
the following components:

• Microarray scanner

• Carousel and 50 slide holders

• PC workstation with recovery software on CD

• Power cables and USB cable
r System (Scan Control Software 8.4) User Guide 11
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1 Introduction
Computer system requirements
• Scan Control Software 8.4

• Feature Extraction Software 10.x 

• Declaration of Conformity

Agilent Scan Control Software 8.4 is designed for use with 
Agilent Feature Extraction Software 9.5 and higher. 5 and 10 
micron, 16- bit scans are backwards compatible with FE 9.5. 2 
and 3 micron scans, and all 20- bit scans, require FE 10.x.
Computer system requirements

Check that you have the following required items prior to 
installing and using Agilent Scan Control software:

Software

• Windows XP Professional with SP2 or Windows Vista 32 
with SP1

• Internet Explorer 5.5 or later 

Hardware

• Pentium IV 3.2GHz or higher

• 2 GB RAM required (4 GB RAM required if Feature 
Extraction software is installed on the same PC)

• 250 GB available disk space for programs and data 
generation 
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide
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Scanner physical description
Scanner physical description
Agilent G2565CA Microarray Scanne
Scanner front view

Air filter vent 

Access lid

Status 
indicator 
lights

Power 
switch

and access door
Figure 2 Microarray Scanner, Front View

Scanner top view

Slide holder 

autoloader armAccess lid

Information 
label

Carousel 
support base
Figure 3 Microarray Scanner, Top View
r System (Scan Control Software 8.4) User Guide
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1 Introduction
Site preparation
Scanner rear view
USB Connection
Laser fuse holder

Power fuses holder

Line voltage
indicator window

Line voltage setting

Air vent

Power plug socket
Figure 4 Microarray Scanner, Rear View
Site preparation

Make sure the environment meets 
the “Microarray scanner 
specifications” on page 96 of 
Chapter 6. If you have any 
questions, contact your local 
Agilent sales and support center or 
www.agilent.com/chem/
dnasupport.
 Make sure

the access lid 
has sufficient 
clearance.

Place on sturdy lab 
bench or table.
6
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Safety symbols on scanner
Safety symbols on scanner
Agilent G2565CA Microarray Scanne
CAUTION symbol

This CAUTION symbol is placed on the product where it is 
necessary for you to refer to the product guide in order to 
understand a potential hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed 
or adhered to, could result in damage to the product or loss of 
important data.
WARNING symbol

This WARNING symbol is placed on the product within the area 
where hazardous voltage is present or electrical shock can 
occur. Only trained service persons should perform work in this 
area.
r System (Scan Control Software 8.4) User Guide 15



1 Introduction
Safety symbols on scanner
Safety guidelines
16 Agilent G25
The Agilent G2565CA Microarray Scanner has been designed for 
safety and ease of use. Be sure you understand and observe all 
the warnings and cautions before operating the microarray 
scanner.
WARNING Do not attempt to repair or gain access to microarray scanner 
internal components. You might expose yourself to high voltage and 
harmful laser radiation. Removing the covers voids the warranty.

WARNING The microarray scanner must be connected to a grounded power 
outlet. It relies on a protective earth ground for safety.

CAUTION If you are turning on the microarray scanner for the first time or have 
moved it to a new site, verify that the voltage setting is correct and the 
voltage is grounded. 

CAUTION Agilent recommends that the microarray scanner be placed on a sturdy 
lab bench or table. The microarray scanner is a potential source of 
vibration and is potentially sensitive to external vibration.

CAUTION The microarray scanner is potentially sensitive to condensing humidity 
conditions. Follow precautions stated in product documentation. See 
“Tips to prevent problems” on page 71 of Chapter 5 and the relative 
humidity specifications on page 96 of Chapter 6.
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide
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Slide positioning
Principles of operation
Agilent G2565CA Microarray Scanne
This section describes the operating features of the Agilent 
G2565CA Microarray Scanner.
Slide positioning

The microarray scanner holds up to 48 1 in  3 in slides in a 
removable carousel. During a carousel run, the slides are 
sequentially transported into scanning position, scanned, then 
returned to the carousel.
Laser excitation

The microarray scanner uses two lasers, a SHG-YAG laser (532 
nm) and a helium- neon laser (633 nm). The lasers excite 
Cyanine- 3 (Cy- 3) and Cyanine- 5 (Cy- 5) labeled RNA or DNA to 
measure fluorescence after hybridization of the target nucleic 
acid to the microarray probes. Dyes similar to Cy- 3 and Cy- 5, 
such as Alexa 647, 555, and 660 dyes, can also be used.

The microarray scanner is optimized for high signal- to- noise 
performance in the Cy- 3 (550—610 nm) and Cy- 5 (650—750 nm) 
emission bands, with a wide dynamic range (up to five orders of 
magnitude) and low spectral cross- talk. This allows for 
measurement of a very broad range of target concentrations and 
for higher data confidence at lower signal levels. 
Scanning

The laser excitation is scanned rapidly back and forth across 
the microarray. The dynamic/tracking auto- focus ensures that 
the microarray is always positioned in the focal plane of the 
scan lens, resulting in scan uniformity.
r System (Scan Control Software 8.4) User Guide 17



1 Introduction
Fluorescence detection
Fluorescence detection
18 Agilent G25
Fluorescence from the labeled samples is converted to an 
electrical signal by a high- performance PMT. Very low noise 
amplifiers and digital integrators process the PMT signal into a 
digital measurement that is recorded in the TIFF file.
Dark offset subtraction

At very low signal levels, noise can cause negative pixel values. 
Rather than setting these values to zero, which results in a 
biased measurement, the Agilent scanner adds a small offset to 
all pixel values, allowing the full pixel distribution to be 
reported. This constant offset is not noise, and is removed in a 
statistically correct manner by Agilent Feature Extraction 
software.
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide
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This chapter describes how to operate the scanner, including 
how to set up and scan your slides quickly and easily. 

If you have any problems, see Chapter 5 for troubleshooting 
information.
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2 Getting Started
Redeeming your high-resolution scanning license
Licensing
20 Agilent G25
The Agilent scanner can be ordered in either of two 
configurations:

• the standard high- resolution configuration, or 

• with the high- resolution capability deleted

Without the high- resolution license, you can select 10 micron, 5 
micron, and 5 micron double- pass, but the 2 and 3 micron 
selections are not available.

If you have purchased the high- resolution capability, you need 
the software license to enable this capability. In most cases, the 
scanner installation engineer will install the license for you. If 
this is not the case, or the capability is purchased later, follow 
the instructions below to redeem the software license.
Redeeming your high-resolution scanning license

To redeem your high- resolution scanning license: 

1 Locate the software entitlement certificate (SEC) that was 
shipped with the scanner.

2 Go to https://software.business.agilent.com/index.stm.

3 Select Click here to start software license redemption. 

4 Follow the instructions to redeem your license.
Installing your high-resolution scanning license 

When you have received your license via e- mail, install the 
license as follows:

1 Close the Scan Control software window.

2 Locate the license file and place it in the following directory:

C:\ProgramFiles\Agilent\Microarray

3 Restart the Scan Control software.

The 2 and 3 micron selections will now be available.
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide
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Getting Started 2
Installing your high-resolution scanning license
Non-Agilent Barcode Licensing
Agilent G2565CA Microarray Scanne
If you need to scan non- Agilent barcodes in 2 or 3 micron 
resolution, contact Agilent for a special no- charge license for 
accessing this capability. 

Without this license, if a slide barcode is not present, or not 
recognized by the scanner as an Agilent array, and the array is 
to be scanned in either 2 or 3 micron resolution, the scanner 
will skip the slide and report the following message:

“Scan settings or slide is not supported by the current scanner 
license. Contact Agilent via pdl-non_ag_barcode@agilent.com to 
obtain license to scan non-Agilent barcodes in high-resolution”.

Obtaining and installing a non-Agilent barcode license

1 Send an e- mail to PDL-non_ag_barcode@agilent.com with your 
scanner serial number in the body of the e- mail, and one will 
promptly be sent to you. This license will need to be renewed 
annually. 

2 Once you receive your license, place the license in the 
following directory:

C:\ProgramFiles\Agilent\Microarray directory

3 Close and re- open the Scan Control software.

The scanner will recognize the new license.
r System (Scan Control Software 8.4) User Guide 21



2 Getting Started
Step 1. Turn on the Agilent Microarray Scanner
Operating the Scanner

Step 1. Turn on the Agilent Microarray Scanner
22 Agilent G25
4 Turn on the Microarray Scanner using the power switch 
located on the front of the instrument. You will notice:

a A fan turns on, and the lid locks.

b The Microarray Scanner begins an initialization routine 
that takes about four minutes. During the initialization, a 
self- test is run during which the status indicator lights 
flash on and off as different functional checks are made.

c The lasers will not turn on until you start the Scan Control 
software.

Figure 5 Location of power switch and status indicator lights

Status 
indicator 
lights

Power 
switch
To learn how to set up to turn the 
lasers on and off automatically, see 
“Setting up times to turn the lasers 
on and off” on page 63 in Chapter 
4.
5 Double- click the Agilent Scan Control icon to open the Scan 
Control program.

Or

Select Start > All Programs > Agilent > Scan Control.

Figure 6 Agilent Scan Control icon

When the program starts, the lasers begin to warm up.
6
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Getting Started 2
Step 1. Turn on the Agilent Microarray Scanner

Agilent G2565CA Microarray Scanne
6 Check the Scanner status message at the bottom of the main 
window. 
Initializing 
Scanner
The scanner is initializing. When the initialization is 
complete, the scanner lid unlocks and the lasers continue 
warming up.
Lasers are 
warming up
The lasers take about 30 minutes to warm up. If you have to 
wait for the lasers to warm up, move on to “Step 2. Insert 
slides into slide holders” on page 24.
Lasers are 
powered off
To turn on the lasers, select Tools > Laser Auto ON/OFF 
Settings... and click Turn Lasers ON Now. 
Scanner ready
 You can begin your scan.

You cannot start a carousel run until both lasers are warmed 
up. 
Figure 7 Scan Control main window when lasers are ready 
r System (Scan Control Software 8.4) User Guide 23



2 Getting Started
Step 1. Turn on the Agilent Microarray Scanner
Step 2. Insert slides into slide holders
24 Agilent G25
A slide must be inserted into a slide holder before loading it into 
the carousel. The slide holder protects the slide during 
scanning. 

Figure 8 Loading slides into the slide holder
Fingerprints cause errors in the 
fluorescence detection. For 
accurate readings, touch only the 
edges of the slide and always use 
gloves when handling slides. 

Also, do not write on the slides 
with markers or place any labels on 
the slide other than an appropriate 
barcode.
1 Hold the slide holder on the sides with the Agilent logo facing 
up.

2 Place one thumb on the center of the slide holder cover.

3 Gently press down on the cover and push toward the top of 
the slide holder until the cover releases.

For instructions on removing the slides, see “Step 5. Remove 
the slides” on page 33.
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide



Getting Started 2
Step 1. Turn on the Agilent Microarray Scanner

Agilent G2565CA Microarray Scanne
Figure 9 Release the cover

4 Place the slide into the slide holder with the end of the slide 
supported fully on the rear ledge.

The active microarray surface must be facing up.

Figure 10 Proper placement of slide on ledge

Released slide 
holder cover

Ledge of slide 
holder

Active microarray 
surface
r Syst
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2 Getting Started
Step 1. Turn on the Agilent Microarray Scanner
5 Align the slide with the slide holder following these two 
rules:

• The end without the barcode label is placed on the rear 
ledge.

• The slide surface on which the microarray is deposited is 
facing the cover. The microarray is scanned through the 
glass.

Make sure these rules are always followed when you align a 
slide.

Agilent slides have two barcodes, one on each side of the 
glass. See Figure 11. Typically, non- Agilent slides have 
only one barcode. Place the active microarray side of the 
slide facing toward the slide holder cover. 
See “Barcode and barcode label 
specifications” on page 99 to apply 
a second readable barcode.
If you have a slide whose spotted array is on the opposite 
side of the slide as the barcode, the scanner cannot read the 
barcode.
CAUTION An improperly inserted slide can damage the Microarray Scanner.
Figure 11 Slide orientation
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide



Getting Started 2
Step 1. Turn on the Agilent Microarray Scanner

Agilent G2565CA Microarray Scanne
6 Let go of other end of slide and allow it to drop into the slide 
holder. 

It is OK if the slide is slightly tilted against the tabs on the 
side of the slide holder.

Figure 12 Slide dropping into slide holder

7 To close the slide holder cover, gently press down on the 
cover with your thumb. 

Figure 13 Close the cover

8 To lock the cover in place, gently pull the cover back with 
your thumb until it locks. 

Tab
r Syste
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2 Getting Started
Step 1. Turn on the Agilent Microarray Scanner
Figure 14 Lock in the cover

9 Verify that the slide holder lid is fully locked into place.

Figure 15 Properly locked cover

Cover locked 
underneath the side 
tabs
65CA Microarray Scanner System (Scan Control S
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Getting Started 2
Step 1. Turn on the Agilent Microarray Scanner
Step 3. Load the slide holders into the carousel
Agilent G2565CA Microarray Scanne
When the slides are properly inserted in the slide holders, you 
can load the slide holders into the carousel. The carousel is 
designed so that you can easily load a slide holder correctly. 
You can load the slide holders either with the carousel in the 
scanner or removed from the scanner.
The Microarray Scanner scans 
slides in the order that they are 
detected as it rotates the carousel 
from lower numbered slots to 
higher numbered slots. The 
carousel run skips over any 
empty slots.
1 Load a slide holder into carousel slot 1, the first slot located 
clockwise from the home position.

Do not place a slide in the carousel home slot. The home slot 
is wider than the other slots and labeled “Home.”

2 Make sure that the tapered end of the slide holder points 
toward the center of the carousel. 

3 Make sure that the slide holder is seated in the bottom of the 
carousel slot. 

Figure 16 Carousel

Home 
slot

Slot 1

Tapered end 
faces toward 
center
CAUTION Improper placement of the slide holder in the carousel can result in 
severe damage to the Microarray Scanner.
4 If the carousel is already mounted, skip to step 5.

Otherwise, mount the carousel.
r System (Scan Control Software 8.4) User Guide
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2 Getting Started
Step 1. Turn on the Agilent Microarray Scanner
If you have placed the slide holders into a carousel that was 
removed from the Microarray Scanner, follow these steps to 
remount the carousel. 

a Mount the carousel so that the carousel alignment pin 
holes fit in with the alignment pins on the Microarray 
Scanner carousel mounting area.

Align the D- shaped hole in the bottom of the carousel with 
the D- shaped center post of the scanner tabletop (where 
the carousel fits) and gently place the carousel into the 
scanner straight down. 

b Make sure that the carousel is firmly seated.
CAUTION When mounting the carousel, be careful not to knock the carousel 
against the autoloader arm. Knocking the autoloader arm can cause 
misalignment.

CAUTION If you need to rotate the carousel manually, do so only when the 
instrument is turned off or you may damage the instrument.
5 (Optional) Place the carousel cover onto the carousel until 
the two side tabs snap into place.

Figure 17 Carousel cover

6 Close the scanner lid.

Tabs

Home slot
65CA Microarray Scanner System (Scan Control Softw
are 8.4) User Guide



Getting Started 2
Step 1. Turn on the Agilent Microarray Scanner

Agilent G2565CA Microarray Scanne
You cannot do any of the following tasks until you close the 
lid:

• Initialize the scanner

• Check the carousel for empty slots

• Read barcodes before the carousel run 

• Start a carousel run

Figure 18 Alignment pins and slots on scanner and carousel 

If an error message appears in the Carousel Log Report that 
says there is a motor time- out, this time- out may be due to an 
improperly mounted carousel. Check the carousel alignment 
and remount, if necessary.

Stationary alignment pins

Movable alignment pin

Stationary alignment pin slots

Movable alignment pin slot
r System (Scan Control Software 8.4) U
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2 Getting Started
Step 1. Turn on the Agilent Microarray Scanner
Step 4. Scan your slides
A scan refers to creating an image of 
the probes on a single slide. A carousel 

run refers to scans of all of the 
specified slides in the carousel.
32 Agilent G25
Follow the steps below to prepare your slides for scanning and 
start the carousel run. See the next section, “Scanning Your 
Slides”, for more detailed instructions.

“Step 1. Set slot locations” on page 36

“Step 2. Set a profile for changing all settings in the scan 
table” on page 37

“Step 3. Change individual scan settings in the scan 
table” on page 38

“Step 4. Start the carousel run” on page 39

“Step 5. Transfer files and archive data” on page 42
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide
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Step 1. Turn on the Agilent Microarray Scanner
Step 5. Remove the slides
Agilent G2565CA Microarray Scanne
After the carousel run is complete, you can unload the slide 
holders from the carousel and then remove the slides from the 
slide holders.

1 (Optional) Remove the carousel from the scanner.

If the slide holder autoloader arm is extended into the 
carousel, do not remove the carousel. Instead, follow the 
instructions in “Troubleshooting an autoloader arm 
extended into the carousel” on page 82.

2 Remove the slide holders from the carousel.

3 Remove the slides from the slide holders.

a Hold the slide holder on the sides with the Agilent logo 
facing up.

b Place one thumb on the center of the slide holder cover.

c Gently press down on the cover and push toward the top 
of the slide holder until the cover releases.

Released slide 
holder cover
r System
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Step 1. Turn on the Agilent Microarray Scanner
d Push up on the barcode end of the slide from underneath 
the slide holder to avoid fingerprints on the sample area.

e Grasp the slide from the sides and remove from slide 
holder.

Figure 19 Proper removal of slide

Push up from underneath
65CA Microarray Scanner System (Scan Contro
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Step 1. Turn on the Agilent Microarray Scanner
Step 6. Set times to automatically turn the lasers off 
Agilent G2565CA Microarray Scanne
You can extend laser lifetime by having the instrument 
automatically power off the lasers at specified times. See 
“Setting up times to turn the lasers on and off” on page 63 
of Chapter 4, “Using Tools” for more information.

You do not need to turn off the microarray scanner.

Should you want to turn off the scanner, follow these 
instructions:

1 Click Exit on the Scan Control main window.

To avoid intermittent communication lock- ups, close the 
Scan Control program before you turn off the Microarray 
Scanner.

2 Wait a few seconds and verify that the Microarray Scanner 
lid is unlocked.

3 Lift the lid.

4 Turn off the power switch on the front of the Microarray 
Scanner.
CAUTION Do not attempt to lift the lid until you hear the lid unlock. Attempting to 
lift the lid while the Microarray Scanner is unlocking the lid can cause 
a jam.
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Step 1. Set slot locations
36 Agilent G25
If you want to scan slides in all 48 slots, skip to “Step 2. Set 
a profile for changing all settings in the scan table” on 
page 37.

1 In the Start slot box, select the number of the slot where the 
first slide that you want to scan is located.

2 In the End Slot box, select the number of the slot where the 
last slide that you want to scan is located.

The range of slots that you enter in steps 1 and 2 affects most of 
the functions in the Scan Control main window. 

• Only the slot range that you enter here appears in the scan 
table.

• The scanner scans only those slides in the slot range that you 
enter here.

• The Carousel Check command checks only the range of slots 
that you enter here for empty slots and for Agilent- supported 
barcodes. (See “Check for Agilent- supported barcodes and 
empty slots” on page 49 of Chapter 3.)
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Step 2. Set a profile for changing all settings in the scan table
Agilent G2565CA Microarray Scanne
• From the Profile list, select one of the existing profiles.
A profile is a collection of scan and 
image settings that, when selected, 
populate the scan table with values 

you entered in the Profile Editor. 
When you open the Scan Control main window, you see the 
columns populated by scan setting values. These values are set 
from the last profile selected for a run before closing the 
program.

Agilent supplies six preloaded profiles for your selection and 
use with Agilent high density microarrays, Agilent G3 
microarrays, and non- Agilent microarrays.
<default>
 Default settings that you see after you install the program
AgilentHD_GX_2Color
 Agilent HD 2- color gene expression microarrays
AgilentHD_GX_1Color
 Agilent HD 1- color gene expression microarrays
AgilentHD_CGH
 Agilent HD CGH/CNV/ChIP microarrays
AgilentHD_miRNA
 Agilent HD miRNA microarrays
AgilentG3_CGH
 Agilent G3 CGH/CNV/ChIP microarrays

To change all the settings at once you can select one of the 
Agilent profiles or create your own from any of the existing 
profiles, including the <Default> profile. 

To edit an existing profile or create your own profile, see 
Chapter 4, “Edit an existing profile” on page 55 or “Create a 
new profile” on page 56.
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38 Agilent G25
If you do not need to change any of the settings in the scan table 
produced by the selected profile, wait until the Scanner status 
message says Scanner ready and move on to “Step 4. Start 
the carousel run” on page 39. 

1 Click the cell(s) whose setting(s) you intend to change.

• Click an individual cell, or

• Click a column header, or

• Drag the cursor down multiple cells in a column to select 
contiguous cells. An arrow appears on the right- hand side 
of the first cell selected.

• Press Ctrl and select non- contiguous cells within a column 
one at a time. An arrow appears on the right- hand side of 
the last cell you select.

2 Select a new setting from the list.

The new setting appears in bold.
.

NOTE An estimate of the total file size and run time is reported in the status line 
at the bottom of the Scan Control main window. Note that space is 
required on the C: drive for temporary files generated while scanning. If the 
estimated image size plus temporary file size exceed the space available, 
the scanner will not permit the carousel run to begin.

CAUTION Agilent recommends that you select an Output Path for storing image 
files to a local drive. If you select a network drive for your output path, 
and the network connection fails, then files are stored on the local C: 
drive in the file Program Files\Agilent\Microarray\NetDataBackup.
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Step 1. Set slot locations
Step 4. Start the carousel run
Agilent G2565CA Microarray Scanne
A carousel run scans all the selected slides in the carousel.

1 Verify that the Scanner status message in the main window 
says Scanner ready.

The carousel run cannot be started until the lasers have fully 
warmed up.

2 Click Scan Slot m- n on the Scan Control main window.

The letter m represents the Start slot where your first slide is 
located, and the letter n represents the End slot where your 
last slide is located.

Two actions take place when you start the scan:

• The scanner lid locks. 

• The Scan Progress dialog box opens showing you the 
status of the scan. 
Figure 20 Scan Progress dialog box 
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Step 1. Set slot locations
Note the messages in the Status window of the Scan Progress 
dialog box that keep you informed of the progress of each scan 
and of the carousel run. 

When the carousel run is complete, the Status box reads 
Carousel run completed. 
The Carousel Report Log presents scan 
information and error messages that 

occur during the carousel run.
At the end of a carousel run the Carousel Report Log 
automatically appears.
Figure 21 Carousel Report Log
If you wish to re- open the final Carousel Report Log after you 
have closed the Scan Progress dialog box, it can be found in:

C:\Program Files\Agilent\Microarray\Logs\CarouselRunLog.htm

This file is overwritten each time a new carousel run is 
started. 

After the run is complete, you can remove the slides. See 
“Step 5. Remove the slides” on page 33.
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View the Carousel Report Log during the run 
You can also view the Carousel Report Log any time during the 
carousel run. 

• Click View Report on the Scan Progress dialog box.

Review the data during or after the run 
Refer to the Feature Extraction 
Software Quick Start Guide, 
included with your scanner 
materials.
• After the data for one scan is transferred, display the file in 
the Agilent Feature Extraction software or another program. 
NOTE If you installed Feature Extraction 10.x on another computer hard drive, 
you must transfer the image files to this drive after the run. See “Step 5. 
Transfer files and archive data” on page 42.
Abort a scan

At any time, you can stop the scan or carousel run. 

• Click the Abort button on the Scan Progress dialog box. 

The following message appears.

Figure 22 Carousel Run Abort message

The Microarray Scanner can take a minute or two to finish 
aborting the scan even if Yes is selected. Any collected data is 
saved for later analysis. 
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• At the end of the run, transfer the files to another folder, if 
needed.

You can transfer the file or files to one of four places:

• New folder under the original folder on the local drive that 
you set up for the Output Path

• Another folder on the local drive

• Folder on the network 

Eventually you must transfer data to the PC where the 
Feature Extraction program resides.

• CD or DVD

A DVD- Writer is included with every PC workstation.
CAUTION It is important to archive data regularly from the scanner PC to make 
sure enough disk space is available for future runs. When the disk is 
almost full, the microarray scanner stops scanning and a caution is 
displayed. 

You can improve performance by regularly defragmenting the disk 
drive.
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Changing scan settings

Changing Scan Table Settings    44

Change scan table settings through profiles    45

Change individual scan table settings    46

Scan Table Settings    48

Before you scan a set of slides, you may want to modify scan or 
image settings.

This chapter first describes each of the scan table settings, then 
shows you how to change all of them at once or one at a time.
43Agilent Technologies
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Changing Scan Table Settings
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You can change the scan table settings in two ways:
A profile is a collection of scan and 
image settings that, when selected, 
populate the scan table with values 

you entered in the Profile Editor. 
• Change all of the settings at once through profiles

• Change individual settings through drop- down lists in the 
scan table

Although you can change entries in any order you want, you 
may want to change the entries in this order to save some 
time:

a If you are scanning non- Agilent slides, you may want 
to “Create a new scan region with the Scan Region 
Editor.” that is more relevant for your slides than the 
ones offered in the scan table or Profile Editor.

b Whether you are scanning Agilent or non- Agilent slides, 
you may want to “Change scan table settings through 
profiles” by selecting a different profile.

c After selecting a different profile (or editing or creating 
one), you can “Change individual scan table settings”. 

If you select a different profile after changing entries 
individually, the profile entries override the changed 
individual ones.

d Be sure to enter Slide IDs either manually or automatically 
after you have selected a profile. You must do this for 
non- barcoded slides. You can do this for Agilent slides. 
See “Slide ID” on page 48.

To learn about each of the scan settings, see “Scan Table 
Settings” on page 48.
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Change scan table settings through profiles
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• From the Profile drop- down list, select the profile whose 
settings you want to use for the run.

Figure 23 Profile drop-down list on Scan Control main window 

You can change the settings for the selected profile (See 
“Edit an existing profile” on page 55) or create a new profile 
from it (See “Create a new profile” on page 56).

When you open the Scan Control main window, you see the 
columns populated by scan setting values. These values are set 
from the last profile selected for a run before closing the 
program.

Agilent supplies six preloaded profiles for your selection and 
use with Agilent high density microarrays, Agilent G3 
microarrays, and non- Agilent microarrays.
AgilentHD_GX_2Color
 Agilent HD 2- color gene expression microarrays
AgilentHD_GX_1Color
 Agilent HD 1- color gene expression microarrays
AgilentHD_CGH
 Agilent HD CGH/CNV/ChIP microarrays
AgilentHD_miRNA
 Agilent HD miRNA microarrays
AgilentG3_CGH
 Agilent G3 CGH/CNV/ChIP microarrays

For Agilent slides you select the profile that applies to your type 
of Agilent microarray.

For non- Agilent slides you will need to make changes to 
individual scan table settings. Or, you can create a new profile 
from an existing one. 
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Change individual scan table settings 
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With this scan table you can change entries for individual slides 
or groups of slides by selecting an item from the drop- down 
menu enabled for each column, except the Slide ID and 
Description columns.

1 Click the cell(s) whose setting(s) you intend to change.

• Click an individual cell, or

• Click a column header, or

• Drag the cursor down multiple cells in a column to select 
contiguous cells.

An arrow appears on the right- hand side of the first cell 
selected.

• Press Ctrl and select non- contiguous cells within a column 
one at a time.

An arrow appears on the right- hand side of the last cell 
you select.

2 Click the arrow to show the drop- down list, and select the 
setting.

Figure 24 Drop-down list for scan region settings

The changed settings appear in bold letters.

See descriptions of these column settings in “Scan Table 
Settings” on page 48.
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Reset scan table settings to current profile values

The profile values that appear when resetting are the original 
values found in the selected profile. 

1 Click the cell or cells whose setting(s) you intend to reset.

• Click an individual cell, or

• Click a column header, or

• Drag the cursor down multiple cells in a column to select 
contiguous cells, or

• Press Ctrl and select non- contiguous cells within a column 
one at a time, or

• Click the Slot header in the upper left- hand corner of the 
table to select all the cells in the scan table.

2 Right- click the selected area, and select Reset to Profile 
Value.

Figure 25 Shortcut menu for returning all selected settings to their orig-
inal values in the current profile 

The settings in the current profile appear in the selected area.
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Scan Table Settings
48 Agilent G25
This section describes the settings in the scan table that you can 
change. The next section tells you how to change them.
Figure 26 Scan Control main window and scan table with preloaded profile settings 
Slide ID
 An identifier for the slide. The Slide ID entries will be used as 
part of the image file name if specified as part of the file name 
in the current profile. See “Naming prefix 1 and Naming 
prefix 2” on page 56.

Automatic entry If your slides have barcodes conforming to the 
specifications in “Barcode and barcode label 
specifications” on page 99, you do not have to enter Slide ID 
into the scan table before the carousel run. The “Auto 
detect” function in the Slide ID column means the scanner 
automatically reads the Agilent- supported barcode into the 
scan table as it scans each slide. 

You also have the choice of entering Slide ID manually. 

Manual entry You must enter IDs for non- barcoded slides, or 
slides with unsupported barcode formats, using the keyboard or 
an appropriate external barcode reader.
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If you enter the ID through the keyboard, double- click the Slide 
ID cell first before typing in the barcode or a unique text 
identifier.

Check for Agilent-supported barcodes and empty slots To view 
the Agilent- supported barcodes and check for empty slots in the 
Slide ID column, you click Tools > Carousel Check.

The program first checks the carousel for empty slots and 
places “No chip” in each Slide ID cell with no slide. Then the 
program reads the barcodes for all the slides and places them 
in the Slide ID cells.
Dye channel
 Determines whether only red (for example, Cy- 5 dye), only 
green (for example, Cy- 3 dye), or both dye channel information 
is gathered. The selection has no effect on the scan time, but 
selecting only one dye channel does reduce file size up to a 
factor of 2.
Scan region
 The scan region determines the area of the slide that is 
scanned. It should be large enough to capture the entire print 
region of the microarray. It should be small enough to avoid 
scanning too close to the barcode or other non- transparent 
border areas of the slide and affecting the scanner's ability to 
autofocus properly. Minimizing the scan region will also reduce 
scan time and save storage space.

Agilent provides a scan region suitable for all Agilent High 
Density and G3 slides, and another suitable for scanning full 1 
by 3 slides without barcode labels.

For non- Agilent slides, you may need to use a custom scan 
region that better matches the printed region. See “Create a 
new scan region with the Scan Region Editor.” on page 60.
Scan resolution 
(µm)
Sets the scan resolution (pixel size) to 2, 3, 5 or 10 microns. 

For 10 micron scans, each row of pixels in the TIFF image 
represents the average of two scan lines, one acquired in each 
direction. For 5, 3 and 2 micron scans, you can select 
double- pass scanning to perform this averaging, or acquire only 
a single scan line for each image row.
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Sets the dynamic range to 16- bit or 20- bit. The G2565CA 
scanner has extended the dynamic range of the PMT and 
signal processing electronics. By selecting the 20- bit TIFF 
file option, you can access this extended range, to enable 
quantitation of high and low signal features in a single scan.

The Scan Control software still enables conventional XDR 
16- bit scanning, as described below.

Below is a table showing the storage space and scan time for 
a single and double pass scans for each resolution selected 
for either a 16- bit TIFF dynamic range or a 20- bit one. The 
Scan Region is 61 X 21.6 mm. 

The Status bar at the bottom of the Scan Control main 
window shows an estimate of the storage space and run 
time required for the complete carousel of slides.

Double pass scans do not require more storage space than 
single pass scans, but they take twice as long to complete. 

Table 1 Storage Space and Scan Time for Single and Double Pass 
Scans for Agilent HD Scan Region 61 x 21.6 mm

Resolution Storage Space, 
Mb, 16-bit

Storage Space, 
Mb, 20-bit

Scan Time, 
min.

2 micron single pass 1300 1600 20

3 micron single pass 620 760 15

5 micron single pass 200 300 8

10 micron single pass 52 115 8

2 micron double pass 1300 1600 40

3 micron double pass 620 760 30

5 micron double pass 200 300 16
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and 

Green PMT Gain
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Sets the sensitivity level of the red channel and green channel 
PMTs. The PMT detects fluorescence emitted by the microarray. 

The default output level (100%) sets the gain to the 
factory- calibrated level; this is the recommended setting for 
Agilent microarrays. You can reduce each color channel setting 
independently to as low as 1%.

If a microarray is so bright that the upper end of the output 
signal is saturated, the PMT sensitivity level can be lowered to a 
sensitivity range that allows all the information to be read. 
XDR Ratio
 Before the availability of the 20- bit TIFF file dynamic range, the 
eXtended Dynamic Range (function) had to be used on both the 
scanner and Feature Extraction software to capture all the data 
scanned between very low signal features and very high signal 
features. Now you can select the 20- bit TIFF file dynamic range 
to capture the wide dynamic range of data as an alternative to 
using XDR.

With the XDR function turned on, the scanner automatically 
scans the same slide twice at two different PMT sensitivity 
levels. This generates two linked images that Feature Extraction 
can co- process to yield a single unified set of extracted intensity 
data covering up to 6+ orders of magnitude. 

The high sensitivity level is set by the Red or Green PMT Gain. 
The XDR function is automatically turned off (once on) at 
values lower than 10%.

Setting the XDR ratio column instructs the scanner to perform a 
second scan at lower PMT settings. For example, if the Red and 
Green PMTs are set to 100%, and the XDR ratio is set to 0.1, then 
the second scan will be performed with the PMTs set to 10%. 
The lowest available PMT setting is 1%.
Output path
 The Browse button lets you select a directory to store the data 
from each scan. Agilent recommends that the data be acquired 
to a local directory on a secondary hard drive. You may also 
select a network directory. If a network access problem is 
experienced during the scan, data will be saved to a temporary 
local directory, and a warning will be included in the carousel 
run report.
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Description of each slide being scanned. This information 
becomes part of the file information that can be viewed in the 
Feature Extraction software. 
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Using Tools

Creating/Editing profiles using the Profile Editor    55

Creating/Editing scan regions using the Scan Region Editor    59

Setting up times to turn the lasers on and off    63

Additional Tools    65

If you want to create or modify a profile or a scan region or if 
you intend to set up times for the lasers to turn on and off 
automatically, you use the tools in the Tools menu. This chapter 
shows you how to use these tools:

Figure 27 Tools menu
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With the Profile Editor you can modify the settings for any of 
the profiles that come with the software: 
<Default>
 The profile whose settings you see loaded upon installation
AgilentHD_GX_
2Color 
Agilent HD 2- color gene expression microarrays
AgilentHD_GX_1Color
 Agilent HD 1- color gene expression microarrays
AgilentHD_CGH
 Agilent HD CGH/CNV/ChIP microarrays
AgilentHD_miRNA
 Agilent HD miRNA microarrays
AgilentG3_CGH
 Agilent G3 CGH/CNV/ChIP microarrays

You can also create new profiles from existing ones.
Scan Region 
Editor
You may need to scan microarray regions not installed by 
default. To create new ones, you use the Scan Region Editor.
Lasers Auto 
On/Off Settings
To extend the lifetime of the lasers, you set up times for the 
system to automatically turn the lasers on and off with this 
dialog box.
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Creating/Editing profiles using the Profile Editor

Edit an existing profile
Agilent G2565CA Microarray Scanne
You can edit and save an existing profile. Or you can edit an 
existing profile and save the edits to a new profile name. 
(See “Create a new profile” on page 56).

1 Select Tools > Profile Editor from the menu bar 
(Figure 27).

Figure 28 Profile Editor 
Note that you can never remove 
the <default> profile from the list. 
You can remove all others, 
including any profiles you create 
from the <default> profile.
2 Select a profile to edit.

3 Change the scan and image settings using the choices 
described in “Changing Scan Table Settings” on page 44 
and “Profile settings not in the scan table” on page 56.

4 Click Save.
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You can create a new profile from any existing profile by saving 
the existing profile as a new name.

1 Select Tools > Profile Editor.

2 Select an existing profile to save as a new one.

3 Click Save As to save the existing file to a new name.

4 Enter the name, then click Save.

5 Change the scan and image settings using the choices 
described in “Changing Scan Table Settings” on page 44 
and “Profile settings not in the scan table” on page 56.

6 Click Save.
Profile settings not in the scan table

The following settings do not appear in the scan table. These 
parameters apply to all scans in the carousel run.
Naming prefix 1 
and 

Naming prefix 2
For standard scans, the Scan Control program uses three name 
segments to compose the filename. 

Prefix1_Prefix2_ScanNumber.tif.

For XDR scans, an additional segment (either _H or _L) is 
added to the filename to distinguish the XDR Hi image from the 
XDR Lo image:

Prefix1_Prefix2_ScanNumber_H.tif 
Prefix1_Prefix2_ScanNumber_L.tif

The default Prefix1 is Instrument Serial #, but you can select either 
Slide ID or your own custom prefix.

The default Prefix2 is Slide ID, but you can select Slot #, Scan Date 
Time or your own custom prefix. 
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• Slide ID – If selected, the entry in the Slide ID cell appears 
in the filename. If <Auto detect> is in the Slide ID cell, the 
barcode will appear in the filename.

• Slot # – The number of the slot in which the scanned slide 
resides

• Scan DateTime – If you select this option, the date and time, 
in format YYYYMMDDHHMM, will be used. 

• Customize – Enter a custom prefix if you select Customize 
(36 character maximum).

The Scan Control program automatically assigns the Scan 
Number. 

The program compares the filename of a new scan with those 
in the selected data directory. 

If Prefix1_Prefix2 is unique, the scan number is set to S01.

If a match is found, the scan number is increased until the 
filename is unique. 

Example

US4510PP02_251485023883_S03.tif   

• Instrument Serial # = US4510PP02

• Slide ID = 251485023883

• ScanNumber = S03. This is the third scan file in the directory 
with the same Instrument Serial # and Slide ID.
Compress TIFF 
You can reduce the final amount of storage space occupied by 
scan images by compressing the TIFF files. 

The compression algorithm used, LZW, reduces the storage 
space by 20 to 70 percent. 
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Some analysis programs require data from one- color images 
rotated 90 degrees. If you set the Split/Rotate option to Yes, the 
color file is split into two color files, and the images are rotated 
90 degrees and flipped. 

An example of the image is shown below:

The split files now have the names of FileName_green and 
FileName_red, where FileName is the name that was 
automatically given to the file before it was split.

If you select only one dye channel for your output file, you must 
still make this selection to rotate the image even if you do not 
need to split the file.

This option is available only for 16- bit TIFF dynamic range 
scans. 
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Creating/Editing scan regions using the Scan Region Editor
The scan region determines the area of 
the slide that is scanned. The larger the 

region, the longer the scan time. Scan 
regions vary because of factors such as 
barcode label placement and size, and 

areas with frosted glass.
Agilent G2565CA Microarray Scanne
If you use non- Agilent slides, you can create your own scan 
region or change a scan region up to the maximum scan region 
of 71 mm x 21.6 mm. The new region appears as a selection in 
the scan table. and in the Profile Editor.
Start the Scan Region Editor 
From the Scan Control main window

• Select Tools > Scan Region Editor from the menu bar 
(Figure 27).

Figure 29 Scan Region Editor 
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Create a new scan region with the Scan Region Editor.
From the Start menu

• Select Start > Programs > Agilent Life Sciences > Scan 
Region Editor on the taskbar.

You cannot access the Scan Region Editor menu item in the 
main window when the scanner is in operation. You can only 
create and change new scan regions through the Start menu. 
Create a new scan region with the Scan Region Editor.

When creating a new scan region or using existing scan regions, 
make sure the scan region is at least 4 mm away from the 
barcode label and does not overlap any other opaque or 
translucent areas of the slide.

1 Select File > New Region from the menu bar in the Scan 
Region Editor.

Figure 30 Add New Region dialog box

2 Enter the name or size of the region.

3 Enter the measurements in mm for the region, using the 
criteria listed below.

Invalid values will be marked in red.
X
 X- axis measurement for the upper left- hand corner. You 
enter this measurement and that of the Y- axis in mm to 
position the region on the slide.
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Y- axis measurement for the upper left- hand corner.
Width
 Width of the scan region measured from the end of the X- axis 
measurement in the upper left- hand corner.
Height
 Height of the scan region measured from the end of the Y- axis 
measurement in the upper left- hand corner.
Ranges
 Range of values that you can enter for each measurement. 

4 Click Save.

If no errors are found, the Scan Region Editor appears with 
the new region listed in the Scan Region Editor. 

Figure 31 Scan regions list 
Show Custom 
regions only
When this check box is marked, only the custom scan regions 
appear in the list in the Scan Region Editor. When the check 
box is clear, you can also see the regions provided by Agilent 
in the list. However, you cannot change these regions with 
the Scan Region Editor.

5 Close the Scan Region Editor.

The newly created regions now appear in the Scan Region 
lists, both in the Profile Editor and the scan table. 
Change an existing scan region for non-Agilent slides

You can only change the scan regions that you created. You 
cannot change or remove the regions provided by Agilent.
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Change an existing scan region for non-Agilent slides
When creating a new scan region or using existing scan regions, 
make sure the scan region is at least 4 mm away from the 
barcode label.

1 In the Scan Region Editor, select the region to change.

2 Select File > Open Region from the menu bar.

The Modify Region dialog box appears.

Figure 32 Modify Region dialog box

3 Change the name or size of the region.

4 Change the measurements for the region, using the criteria 
listed in “Create a new scan region with the Scan Region 
Editor.” on page 60.

5 Click Save.
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Setting up times to turn the lasers on and off 
Agilent G2565CA Microarray Scanne
To extend the life of the scanner lasers, you can enable the Scan 
Control program to turn the lasers on or off automatically. This 
feature allows you to have the laser warmed up and ready for 
scanning at a specified time or turned off automatically at a 
specified time or when idle.

Regardless of Laser Auto ON/OFF settings:

• You can turn the lasers on or off manually anytime.

• When you start the Scan Control program, the lasers turn on. 

• If the scanner is scanning at the specified turn- off time, the 
lasers will remain on.
Enable the lasers to turn on or off automatically

1 Select Tools > Laser Auto ON/OFF Settings from the menu 

bar (Figure 27).

2 Double- click No to set Enable laser auto ON/OFF to Yes.

Figure 33 Laser Auto ON/OFF Settings properties page 
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Turn the lasers on or off manually
NOTE If the selection is NO, you must turn the lasers on and off manually, as 
described in the next section.
Turn ON daily
64 Agilent G25
Select Weekdays only or Weekends, and specify the time for 
turning the lasers ON on weekdays or weekends. 
Turn OFF daily
 Select Yes and specify the time for turning the lasers OFF on 
weekdays and weekends. 
Turn OFF when idle
 Select Yes and specify a time span of scanner inactivity 
beyond which the scanner turns off the lasers. If No, the 
scanner will not turn off under this condition.

3 Click OK.
Turn the lasers on or off manually

1 Open the Laser Auto ON/OFF Settings properties page.

2 Click Turn Lasers on Now or Turn Lasers off Now.

3 Click OK.
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Additional Tools
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The following additional tools are available on the Tools menu.
Unlock Door

The unlock door tool (Tools > Unlock Door) can be used to 
attempt to manually unlock the door if the door lock did not 
operate correctly. This can happen, for example, if the lid is 
being lifted as the lock operates automatically at the end of a 
carousel run.
Reset Calibration Warnings

During normal operation, the G2505C scanner calibrates the 
PMTs before every scan, and calibrates the lasers during system 
initialization and after every carousel run. If the calibration is 
unsuccessful, or if the calibration changes significantly since 
the previous time it was performed, the scanner software will 
record that fact, and generate warnings in the Carousel Run 
Log.

The PMT calibration warning is set when the PMT voltage 
changes by more than 20% from the previous calibration value.

The laser calibration warnings are set when the lasers cannot 
achieve their specified power within the warm up period. If this 
occurs, the system sets the warning, and recalibrates the lasers 
at 80% of their specified power. The Scan Control program 
scales the TIFF file to compensate for the lower laser power.

You can reset these warnings by selecting Tools > Reset 
Calibration Warnings.

If the next calibration is again unsuccessful, and the warnings 
reappear, you should contact your local Agilent sales and 
support center.
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Extended Laser Calibration
Extended Laser Calibration
66 Agilent G25
Normal calibration of the lasers does not measure the maximum 
power output. The extended laser calibration tool performs a 
more comprehensive check of the laser subsystem. If you are 
receiving repeated laser calibration warnings, Agilent support 
may request that you use the extended laser calibration tool, 
then e- mail the log files containing the results.
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This chapter provides maintenance and troubleshooting 
information for the Agilent G2565CA Microarray Scanner 
System. 
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Scheduled software maintenance
Maintaining your system
68 Agilent G25
With proper care and maintenance, the microarray scanner will 
provide you with trouble- free use. When in doubt about the use 
or care of the microarray scanner, contact your local Agilent 
sales and support center to answer your questions. 
Scheduled 
maintenance 

tasks
These sections describe the software and hardware 
maintenance tasks that you need to perform on a regular basis 
to keep the microarray scanner operating efficiently. 
Tips to prevent 
problems
This section presents hints on the operation and care of the 
microarray scanner to help you avoid problems.
Scheduled software maintenance

Perform these tasks to help maintain the performance of your 
PC workstation and MS Windows operating system:

• At least once a week, check disk space and archive data as 
needed.

• Once a week delete any temporary files (*.mp, *.tmp files) 
from the c:\Temp folder.

• If sluggish performance is observed, defragment the hard 
disk using defragmentation software. 
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Scheduled hardware maintenance
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Perform these tasks to help maintain the performance of your 
microarray scanner.

Inspecting the vents and air filter 

Good air flow through the microarray scanner is essential to 
proper operation. Blocked vents and dirty air filters can 
adversely affect performance.

Vents Check all vents weekly to ensure that they are not 
blocked by dust, debris, furniture, or other instrumentation.

Air filter The air filter in the microarray scanner should be 
checked once a month for excessive dirt, using the following 
procedure:

1 Turn the microarray scanner off.

2 Open and remove the air filter access door, which is located 
on the right side of the microarray scanner.

Figure 34 Opening and removing the air filter access door

3 Remove the air filter from the door housing, and inspect the 
air filter visually.

Removable air 
filter access 
door
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Figure 35 Removing the air filter

Cleaning the air filter

If excessive dirt has built up, or six months have passed since 
the air filter was cleaned, clean the air filter.

1 Wash the air filter in warm water.

2 Squeeze the air filter to wring out the water. 

All excess water should be wrung out of the air filter. 

3 Allow the air filter to dry completely before installing. You 
can use paper towels to blot the filter dry.

4 Re- install the air filter in the air filter access door housing 
and close the door.

Verify that the air filter was replaced after drying. Failure to 
replace the air filter can cause dust buildup inside the 
instrument that could adversely affect performance. 

Air filters (p/n 3150- 0956) can be ordered directly from your 
local Agilent sales and support center.

Air filter access door

Air filter
65CA Microarray Scanner System (Scan Control So
ftware 8.4) User Guide



Maintaining and Troubleshooting Your System 5
Scheduled software maintenance
Tips to prevent problems
Agilent G2565CA Microarray Scanne
Perform the scheduled maintenance tasks described on the 
previous pages, and follow these tips to help you maintain the 
microarray scanner and its performance.

Tips to avoid data loss

• Avoid loading software programs that cause high CPU 
workload, as this might affect the acquisition of data during 
scanning.

Tips to avoid environmental damage to the scanner

• Keep liquids and vapors away from the microarray scanner.

• Minimize and control temperature fluctuations.

Do not place the microarray scanner in direct sunlight. Do 
not locate the microarray scanner near windows even if they 
have blinds or window coverings. The hot sun can heat up 
the microarray scanner’s housing in a non- uniform fashion, 
which may cause problems with the alignment of the optics.

Scan only when the laboratory temperature is consistent 
with the operating temperature specifications for the 
microarray scanner. To assure optimal microarray scanner 
performance, operate the scanner only in the specified 
temperature ranges. (See “Microarray scanner 
specifications” on page 96.)

• Control the humidity.

The microarray scanner is potentially sensitive to 
condensing humidity conditions. To ensure optimal 
performance, operate the microarray scanner only in the 
specified humidity ranges. (See “Microarray scanner 
specifications” on page 96.) Always allow 10 hours 
thermal equilibration time on site before opening the 
shipping box.
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Tips to maintain hardware performance

• Avoid moving the microarray scanner.

If you need to move the microarray scanner, there is a chance 
that its performance could be adversely affected. Call your 
local Agilent sales and support center for assistance in 
moving the microarray scanner.

• Place the microarray scanner on a sturdy lab bench or table.

• Avoid leaning on the microarray scanner.

• To extend the life of the lasers, set up to automatically power 
your lasers on and off. See “Setting up times to turn the 
lasers on and off” on page 63 of Chapter 4.

• After turn- on, allow time for laser warm- up and stabilization. 
The maximum warm- up time is 30 minutes. 

• Keep carousel floor clean using a wipe and no solvent.

• Do not use acetone or other solvents for cleaning.

• Do not touch gearing in the carousel area.
WARNING Do not remove the covers. Do not attempt to repair or gain access to 
internal components. You might expose yourself to high voltage and 
harmful laser radiation.
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Troubleshooting your system
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The Agilent Microarray Scanner was designed for 
low- maintenance requirements and high user- friendliness. If 
you cannot resolve the problem you are experiencing with the 
system, please read over this chapter before calling your local 
Agilent sales and support center.
Technical support
 This topic gives important information about technical support. 
Frequently 
asked questions
Refer to this section to learn about solutions to frequently asked 
questions related to support and maintenance. 
Hardware 
troubleshooting
This topic describes the indicator lights and how to replace the 
fuses. 
Software 
troubleshooting
This topic covers the precautions you must take when you use 
the Recovery CD to recover the software and data on your hard 
drive.
Scanner error 
messages
Refer to this topic to learn about important error messages and 
solutions.
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Technical Support
74 Agilent G25
Technical support is available for the Agilent Microarray 
Scanner System. Please read the rest of this chapter prior to 
calling your local Agilent sales and support center. 

Use the Web to reach technical support

The software arrives with a default URL that lets you access 
Agilent technical support for the microarray scanner. 

• Click Help > Technical Support.

PC workstation support

If you have a problem with your PC workstation, see the 
documentation that came with the PC. 

If you are still unable to resolve the problem, contact your local 
Agilent sales and support center or click Help > Technical 
Support.

Microarray scanner support

If you have a problem with your microarray scanner that 
requires assistance from your local Agilent sales and support 
center, you may be asked to provide the latest diagnostic log 
files that the Scan Control program created. These files are 
located in the folder C:\Program Files\Agilent\Microarray\Logs. 

Additional diagnostic information, including results of the 
Power- on Self Test, can be captured using the HyperTerminal 
program. See “Using HyperTerminal to Capture Diagnostic 
Data” on page 83 for more information on setting up and 
using this communication protocol.

Each Agilent Microarray Scanner is identified by a unique 
10- character serial number. The serial number is located on a 
label in two places on the microarray scanner: one in the 
carousel bay and one behind the filter door.

When corresponding with your local Agilent sales and support 
center about your microarray scanner, be sure to include the 
model number and 10- character serial number. 
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Please make a note of the serial number of your Agilent 
Microarray Scanner, the software version # and the installation 
date in the spaces below (if you print this page) or on a sheet of 
paper that you keep close to your scanner.

Scanner information

Model #: 

Serial #: 

Installation Date:

Software Version#: 

Software Update Version#/Date: 

Software Update Version#/Date: 

Find the version information for scanner software 

1 Select Help > About from the menu bar to find version 
information.

2 To close the program, click OK.
r System (Scan Control Software 8.4) User Guide 75



5 Maintaining and Troubleshooting Your System
Technical Support
Frequently Asked Questions (FAQs)
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The following are frequently asked questions (FAQs) and the 
corresponding answers that can help you operate and maintain 
the Agilent Microarray Scanner System and troubleshoot issues 
that occur.
Table 2 FAQs 

FAQ Answer

I want to move the microarray scanner to 
another area.

Scanner performance could be adversely affected by the move. Call your local 
Agilent sales and support center for assistance in moving the scanner and 
assuring proper operation afterwards.

Can I save files over the network while 
scanning?

Agilent recommends that you save your data files directly to the local hard disk. 
Data files may also be saved to a network directory. If a network access problem 
is experienced during the scan, data will be saved to a temporary local directory, 
and a warning will be included in the carousel run report.

Where do I find support information, 
such as drivers, guides, and 
troubleshooting solutions, for my PC 
workstation?

If you have a problem with your PC workstation, see the documentation that 
came with the PC. If you are still unable to resolve the problem, contact your 
local Agilent sales and support center.

I cannot open the top lid to access the 
carousel.

Do not attempt to force the lid open. Forcing the lid could damage the microarray 
scanner. 

1 Push down on the lid to reduce any existing spring tension, and then attempt 
to open the lid. If this fails, then go to step 2.

2 Close and then restart the Scan Control program.
3 Try opening the lid.
4 If the lid still does not open, close the Scan Control program and turn the 

microarray scanner off, then back on. 
5 Try opening the lid.
6 If the lid still does not open, contact your local Agilent sales and support 

center.

The Scan Control program does not 
respond.

The Scan Control program has stopped responding—no changes in the status 
message for more than 15 minutes and you are unable to close the program. Do 
the following:

1 Open the Windows Task Manager (Ctrl-Alt-Del) and close the Scan Control 
program. Then restart the Scan Control program.

2 If the previous step fails, reboot the PC workstation, turn the microarray 
scanner off and then back on, wait for the yellow status indicator light to go 
off, and then restart the Scan Control program.
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide



Maintaining and Troubleshooting Your System 5
Technical Support
What do I do if a slide is only halfway 
inserted in the carousel by the 
autoloader arm?

1 Gently push or pull the autoloader arm, whichever resists least, to the end of 
its range. Don't force it.

2 Close and restart the Scan Control program.
3 If the problem persists, call your local Agilent sales and support center.

The microarray scanner is turned on, but 
the yellow light does not go off after 20 
minutes.

1 Verify that the PC workstation is turned on.
2 Verify that the USB cable is connected from the PC workstation to the 

microarray scanner.
3 Contact your local Agilent sales and support center.

The microarray scanner is turned on and 
the Scan Control program is open, but 
the scanner won’t scan.

1 Close and then restart the Scan Control program.
The microarray scanner must be turned on before the Scan Control program is 
started. If you started the Scan Control program first, the connection is not 
made when the scanner is turned on.

2 Contact your local Agilent sales and support center.

Table 2 FAQs (continued)

FAQ Answer
Agilent G2565CA Microarray Scanne
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Hardware Troubleshooting
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The microarray scanner has very few parts that you can service 
yourself. You can take actions based on the errors shown by the 
status indicator lights on the front. You can also replace the 
fuses that protect the system. Any other problems, including 
jams, should be handled by contacting your local Agilent sales 
and support center.

If you are having a problem with your PC workstation, see 
“PC workstation support” on page 74 for support 
information.

Troubleshooting with the status indicator lights

The front panel holds three status indicator lights indicating the 
current status of the microarray scanner. 

Figure 36 Location of the status indicator lights

Table 3 describes the actions that you take given the status of 
the indicator lights.

Status 
indicator 
lights
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Table 3 Indicator Light Status 

LED Status Possible
Causes

Suggested
Action

Green Yellow Red

Off Off Off No power to the scanner. Check the following:

• power switch is on
• power cord is plugged in and 

there is power at the source
• power fuses are not blown

Flash once Flash once Flash once LED test at power-on 
(duration < 1 sec.)

No action required.

Flashing Flashing Off Power-on Self Test in 
operation

No action required. Use 
HyperTerminal to capture 
diagnostic information. See “Using 
HyperTerminal to Capture 
Diagnostic Data” on page 83.

Off Flashing 

(20 sec. off/ 
20 sec. on)

Off Attempting to connect to PC Install Scan Control Software 8.0 if 
not already installed.

Off or On Flashing 
(period = 1.3 
or 1.0 sec.)

Off Firmware downloading and 
DSP initializing

No action required.

On On Off Lasers are warming up and 
are not ready to scan.

Wait. Maximum warm-up time is 30 
minutes. 

On Off Off Instrument is ready to scan. No action required.

Flashing Off Off Instrument scanning No action required.

Any condition Any condition On Error detected. Contract your local Agilent sales 
and support center.
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Checking and replacing scanner fuses

The microarray scanner has three fuses, two fuses for the power 
supply and one fuse for the red laser. The fuses can be found on 
the rear of the microarray scanner. The power supply fuses are 
directly above the power cord plug. The laser fuse is located in a 
circular fuse holder to the left of the power cord plug.

The fuses can be ordered directly from Agilent Technologies.
WARNING Always disconnect the power cord before checking or replacing the 
fuses.
Checking and replacing the power supply fuses If the microarray 
scanner cannot be powered on even though the power outlet is 
active when tested, you should check and replace the fuses if 
needed. You do this from the rear of the unit. 

1 Disconnect the power cord.

2 Use a small flat- edge screwdriver to pry up the small plastic 
tab located on the bottom edge of the fuse holder until it 
releases.

3 Pull out the fuse holder, and check the fuse integrity.

4 If a fuse is blown, replace the fuse with a T4A, 250 VAC rated 
fuse (Part# 2110- 1309).

5 Push the fuse holder back in until it clicks into place.

6 Plug in the power cord.
CAUTION Replace the fuses with only the same or equivalent rated fuses. If you 
are unsure about the fuses, contact your local Agilent sales and 
support center before installing.
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Power supply 
fuse holder
Figure 37 Removing the fuse holder for the power supply

Checking and replacing the red laser fuse If the microarray 
scanner can be powered on but the red laser is not on, you can 
easily check and replace the laser fuse from the rear of the unit. 

1 Disconnect the power cord.

2 Use a small flat- edge screwdriver to unscrew the small 
plastic circular cap until it releases.
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Figure 38 Laser fuse holder location

3 Pull out the fuse holder, and check the fuse integrity.

4 If a fuse is blown, replace the fuse with a T500mA, 250 VAC 
rated fuse (Part # 2110- 0458).

5 Push the fuse holder back into place and screw on the cap.

Troubleshooting an autoloader arm extended into the carousel

1 Turn off the scanner.

2 Rotate the carousel and push the arm back into position.

If this does not work, call your local Agilent sales and support 
center for instructions.

Laser fuse holder
CAUTION Removing the carousel when the slide holder autoloader arm is 
extended into the carousel will cause serious damage to the 
microarray scanner. 
6
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Using HyperTerminal to Capture Diagnostic Data
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Agilent service personnel and users can capture information for 
troubleshooting the scanner by setting up a HyperTerminal 
session. These instructions apply to Windows XP systems. 
For instructions on capturing diagnostic data for scanners 
operating on Windows Vista 32 systems, please see the 
release notes associated with Scan Control Software version 
8.4

Set up HyperTerminal

1 Turn on the scanner to start initialization.

2 Start the Scan Control program to turn on the lasers.

3 Make sure the scanner is on for at least 30 seconds before 
starting HyperTerminal (step 4).

4 Click Start > Programs > Accessories > Communications > 
HyperTerminal.

5 In the Connection Description dialog box:

a Type Scanner in the Name text box.

b Click OK.
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CAUTION When the scanner is turned on and HyperTerminal is running, the 
scanner cannot initialize. Wait at least 30 seconds after you turn on the 
HyperTerminal must be started no earlier than 30 seconds after the 
scanner has been turned on.
84 Agilent G25
6 In the Connect To dialog box:

a From the Connect using drop- down list, select the 
highest COMX number.

This will usually be COM3, but you can verify this 
through Windows Device Manager. The scanner COM 
port is listed as “USB Serial Port (COMX)”.

b Click OK.

7 From the COMX Properties dialog box:

a Select 19200 as Bits per second.

b Select None as Flow Control.
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c Click OK.

The Scanner -  HyperTerminal window appears.

8 Click File > Save to save the file to Scanner.ht, and close the 
window.

9 Click Yes when asked if you want to sever the connection.

10 Create a Scanner.ht shortcut icon on the Desktop:

a Click Start > Programs > Accessories > Communications.

b From the HyperTerminal submenu, right- click Scanner.ht.

Note that the HyperTerminal submenu has been added to the 
bottom of the Communications menu. Do not right- click the 
HyperTerminal program icon towards the top of the menu.

c From the shortcut menu, click Create Shortcut.

d Click and drag Shortcut to Scanner.ht to the Desktop.
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11 Start a HyperTerminal text capture session:

a Double- click the Scanner.ht icon on the Desktop.

b Click Transfer > Capture Text.

c Click Browse.

d In the Select Capture File dialog box, find the Archive (E:) 
drive.

e Create a new folder named Support.

f In the Support folder, create a new folder and call it 
HyperTerminal Capture Files.

g In the HyperTerminal Capture Files folder, type the 
filename Capture yymmdd-# in the filename text box, 
where yymmdd represents today’s date, and # represents 
the number of the capture session for that day.

h Click Save.

i Click Start in the Capture Text dialog box.

HyperTerminal data will continue to append to this file until 
HyperTerminal is closed or the Capture Text… session is 
stopped from the Transfer drop- down menu.

HyperTerminal will close when you log off.

Start a HyperTerminal capture session after initial set-up

If the lasers are warmed up, skip to step 3.

1 Turn on the scanner to start initialization.

2 Start the Scan Control program to warm up the lasers.

3 Double- click on the Desktop Scanner.ht icon.

4 From the HyperTerminal Transfer drop- down menu, click 
Capture Text.
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5 In the Capture Text dialog, 

a Change the filename in the File text box to reflect today’s 
date and capture session.

b Click Start.

You can also click Browse to open the Select Capture File 
dialog box. From the Select Capture File dialog box choose a 
new folder or a new filename, or else your original capture 
session file will be overwritten. When you are done, click 
Save to continue.
Software Troubleshooting

In case your computer crashes or you want to reload the hard 
drive image that Agilent ships with the PC, Agilent supplies a 
recovery CD that lets you re- image the hard drive. 

To use this CD successfully you must disconnect the USB cable 
that attaches to the back of the PC before you use the CD.
CAUTION If you do not disconnect this cable, the Agilent default settings for the 
USB devices may be changed, and the software will not recognize the 
scanner when you restart the software.
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Microarray Scanner Error Messages
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This section explains how to use error messages you may 
encounter.

Sources of error messages

The computer monitor shows error messages for the microarray 
scanner hardware, the Scan Control and Feature Extraction 
software, Microsoft Windows, and the PC workstation. Check 
the title bar of the error message to determine the source of the 
error message.

Figure 39 Title bar of a Scan Control error message 

This topic presents the error messages for the microarray 
scanner hardware and the Scan Control program.

If the title bar indicates that you are having a problem with your 
PC workstation or Windows, see “PC workstation 
support” on page 74 for support information.

Where scanner error messages can appear

Error messages can appear in the following places:

• Errors during the microarray scanner initialization appear 
in the Scanner status message in the Scan Control 
window. See “Step 4. Scan your slides” on page 32 of 
Chapter 2.

• Errors before the scan starts are shown in message boxes.

• Some errors during the scan are shown in the Status message 
in the Scan Progress dialog box.

The title bar of the error message indicates that
this message is related to the carousel hardware.
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• Error messages are logged in the Carousel Report Log as the 
carousel run progresses. See “View the Carousel Report 
Log during the run” on page 41 of Chapter 2. 

We recommend that you check the Report Log at least after 
the first scan and when the carousel run is completed. The 
report is automatically generated at the end of a carousel 
run.

Troubleshooting with error messages

The Agilent Microarray Scanner System creates error messages 
to help you solve issues that may arise. Many of the error 
messages include a solution within the text box; follow those 
instructions.

The following table contains some of the error messages that 
appear without instructions. These descriptions contain 
information that can help you resolve your problem.
Table 4 Error Messages 

Error Message Description or Solution

Application Is Already Running You cannot run two copies of the Scan Control program at the same time.

Autofocus error: Did not detect two 
reflective surfaces during home.

Do the following:

1 Verify that the slide is inserted properly in the slide holder. See “Step 2. Insert 
slides into slide holders” on page 24, or try another slide holder.

2 Verify that the slide meets the Agilent specifications. See “Slide 
specifications” on page 98. 

3 If the problem persists with one slide, then something might be wrong with 
that slide.

4 If needed, select or create an appropriate scan region. For some non-Agilent 
slides with translucent or opaque borders, the scan region selected may be 
located too near to the non-transparent areas of the glass. See “Create a new 
scan region with the Scan Region Editor.” on page 60.

5 Contact your local Agilent sales and support center. 
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Software Troubleshooting
Autofocus error. No PSD signal is 
detected. Make sure there is a slide in the 
chip holder.

Do the following:

1 Verify that the slide is inserted properly in the slide holder. See “Step 2. Insert 
slides into slide holders” on page 24,

2 Verify that the slide meets the Agilent specifications. See “Slide 
specifications” on page 98. 

3 If the problem persists with one slide, then something might be wrong with 
that slide. 

4 For some non-Agilent slides with translucent or opaque borders, the scan 
region selected may be located too near to the non-transparent areas of the 
glass. See “Create a new scan region with the Scan Region Editor.” on 
page 60.

5 Contact your local Agilent sales and support center. 

Autofocus was unable to retain focus as 
it travelled to the scan start position.

Do the following:

1 Verify that a barcode has not obstructed the scan start position.
2 Choose a smaller scan region.
3 If the problem persists with one slide, then there might be something wrong 

with that slide. 
4 Contact your local Agilent sales and support center. 

Cannot eject chip. There is already a chip 
in the slot.

Do the following:

1 Open the scanner lid.
2 Remove the slide holder from the home slot.

Cannot load chip, moving the arm may be 
unsafe.

Do the following:

1 Open the scanner lid.
2 If the AL Arm is partially extended into the carousel compartment, gently 

push it back into the scanner until it comes to a stop.
3 If the problem persists, contact your local Agilent sales and support center.

Command timed out. Do the following:

1 Verify that the USB cable from the microarray scanner to the PC workstation 
is connected. 

2 Turn the microarray scanner off, then on again.
3 Restart the Scan Control program.
4 If the problem persists, contact your local Agilent sales and support center.

Table 4 Error Messages (continued)

Error Message Description or Solution
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Connection manager reports that there 
are no instruments.

Possible causes for this error include:

• The microarray scanner might not be on, or you turned on the microarray 
scanner but did not wait long enough for the microarray scanner to complete 
its self-test and initialization. Select OK to close the Scan Control message, 
wait a few minutes, and try again.

• The microarray scanner might not be connected to the PC workstation. Verify 
the USB cable is connected to both the microarray scanner and PC 
workstation. If the USB cable is disconnected, reconnect the cable, reboot the 
PC computer, and if needed turn the microarray scanner off then on.

• The Internet Protocol (TCP/IP) networking properties for the scanner may 
have been altered. Verify that the IP address for the scanner's Local Area 
Connection is 10.0.0.1 and its subnet mask is 255.255.255.0.

• Windows XP firewall may be preventing communication. Disable the firewall.
• If you rebooted the PC workstation, you may need to turn the microarray 

scanner off, and then back on, after Windows has restarted.

Error ejecting chip. The chip was ejected 
into the home slot.

Do the following:

1 Turn off power to the scanner.
2 Open the scanner lid.
3 Rotate the carousel by hand until access to the home slot is not blocked by 

the Autoloader Arm.
4 Remove slide from home slot.
5 Gently push the Autoloader Arm back into the scanner until it comes to a 

stop.
6 If the problem persists, contact your local Agilent sales and support center.

Failed to communicate with connection 
manager.

Do the following:

1 Reboot the PC workstation.
2 Turn the microarray scanner off and then back on.
3 After several minutes, start the Scan Control program.

Lasers never became ready. Do the following:

1 Verify that the number showing in the voltage selector on the back of the 
scanner matches the input power supplied.

2 If you rebooted the PC workstation, you may need to turn the microarray 
scanner off and then back on, after Windows has restarted.

3 If the problem persists, contact your local Agilent sales and support center.

Table 4 Error Messages (continued)

Error Message Description or Solution
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Missing or corrupt ChipRegions.ini file. Do the following:

1 If you have a backup copy of your customized ChipRegions.ini file, copy it to 
C:\Program Files\Agilent\Microarray. Having a backup copy of 
ChipRegions.ini will avoid loss and re-creation of custom scan regions.

2 If you don't have a backup copy, search the folder for ChipRegions.bak, and 
rename it to ChipRegions.ini.

3 If neither file exists, re-install the Scan Control program.
4 Contact your local Agilent sales and support center.

Not enough disk space to create file. The hard drive does not have enough disk space to create a file to store scan 
data. You can do one of the following:

• Go to the Scan Control main menu and set the output directory to another 
directory on another hard drive.

• Delete or transfer files from the current hard drive. See “Step 5. Transfer files 
and archive data” on page 42.

PMT calibration may be unstable. Using 
last known PMT setting.

You can reset this warning using the Reset Calibration Warnings tool. See 
“Additional Tools” on page 65. If this warning persists or reoccurs, contact your 
local Agilent sales and support center.

PMT calibration lost! Using factory 
default settings.

You can reset this warning using the Reset Calibration Warnings tool. See 
“Additional Tools” on page 65. If this warning persists or reoccurs, contact your 
local Agilent sales and support center.

Slide skipped because it is outside the 
allowable thickness range or the selected 
scan region contains an obstruction to 
the initial focus positions.

Do the following:

1 Check the skipped slide for a barcode, hybridization residue, or other 
non-transparent obstruction that has interfered with the initial focus position. 
The primary initial focus position is located 1 to 2 mm to the left of the scan 
region on the top row of the scan region.

2 Measure the glass thickness and verify that it meets with the specifications 
in “Slide specifications” on page 98.

The autoloader loading arm is in an 
unknown location. It is unclear if it is safe 
to move the carousel.

Do the following:

1 Open the scanner lid.
2 If the Autoloader Arm is partially extended into the carousel compartment, 

gently push it back into the scanner until it comes to a stop.
3 Close and restart the Scan Control program.
4 If the problem persists, contact your local Agilent sales and support center.

The chip carousel is not present. Please 
place the carousel in the scanner and try 
again.

Put the carousel in the microarray scanner and reinitiate the carousel run. See 
“Step 2. Insert slides into slide holders” on page 24.

Table 4 Error Messages (continued)

Error Message Description or Solution
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The carousel may be misaligned. Please 
remove the carousel, make sure that its 
opening is aligned with home position 
and reinsert the carousel.

See “Step 2. Insert slides into slide holders” on page 24.

The slide failed to eject. Pressing OK will 
re-initialize the instrument.

When you press OK, the microarray scanner re-initializes. If this fails, do the 
following:

1 Open the scanner lid.
2 If the Autoloader Arm is partially extended into the carousel compartment, 

gently push it back into the scanner until it comes to a stop. Do not force it if 
it does not move easily.

3 Close and restart the Scan Control program.
4 If the problem persists, contact your local Agilent sales and support center.

The software has detected a serious 
sensor error that may have existed prior 
to the installation of this version of 
software.

Contact your local Agilent sales and support center.

Unable to lock instrument specified by 
connection manager.

Do the following:

1 Reboot the PC workstation.
2 Turn the microarray scanner off and then back on.
3 Start the Scan Control program.

You must select a region to scan first. To enter a scan region not specified in the selected profile into the scan table:

1 Select the slot or slots whose region you intend to enter.
2 Click the down arrow next to the selection(s).
3 Select a scan region from the Scan region list. See “Change individual scan 

table settings” on page 46. 
4 Start the scan or carousel run. 

You must select at least one dye channel. 1 Select the slot or slots whose dye channel you intend to change.
2 Click the down arrow next to the selection(s).
3 Select a dye channel setting from the list. See “Dye channel” on page 49.

Table 4 Error Messages (continued)

Error Message Description or Solution
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Software Troubleshooting
You must close the door first. Microarray scanner initialization and scan operations cannot be performed with 
the microarray scanner lid open. Close the lid.

Warning: The laser power does not fall 
within expected thresholds. Please 
contact an Agilent representative.

Wait the required warm-up time (about 30 minutes) when the status message in 
the Scan Control program says Status Ready. You can reset this warning using 
the Reset Calibration Warnings tool. See “Additional Tools” on page 65. If this 
warning persists or reoccurs, contact your local Agilent sales and support 
center.

The Scan Control program scales the TIFF file to compensate for the lower laser 
power.

Table 4 Error Messages (continued)

Error Message Description or Solution
94 Agilent G25
If an error message does not appear in the table

This table does not list all the possible error messages. If you 
have an error message that is not listed and you are unable to 
resolve the problem, do the following:

1 Write down the error message.

2 Restart the Scan Control program.

3 If step 2 does not solve the problem, do the following:

a Reboot the PC workstation.

b Turn the microarray scanner off, then back on.

c Restart the Scan Control program.

4 If step 3 does not solve the problem, contact your local 
Agilent sales and support center.
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Agilent G2565CA Microarray Scanner System
(Scan Control Software 8.3)
User Guide
6
Reference

Microarray scanner specifications    96

Slide specifications    98

Regulatory information    102

Input voltage check    105

This chapter includes specifications, regulatory information 
and instructions for checking the voltage if you move the 
instrument.
Microarray scanner 
specifications
This section describes the specifications for the microarray 
scanner instrument. For specifications for the PC workstation, 
see the user guide that came with the PC. 
Slide specifications
 This section presents the glass and barcode specifications that 
the scanner is designed to accept.
Regulatory 
information
This section lets you know which regulations for acoustic noise, 
recycling and disposal, electromagnetic interference, and safety 
that the microarray scanner complies with.
Input voltage 
check
In this section you can make sure the input voltage is correct 
after a move.
95Agilent Technologies
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Microarray scanner specifications
96 Agilent G25
The microarray scanner operates within the following 
specifications: 
Approximate 
dimensions
Height: 97 cm (38 in); with lid closed, 55 cm (21.5 in)

Width: 91 cm (36 in)

Depth: 71 cm (28 in)

These dimensions account for maximum height and width when 
access doors are open and for an 80 mm (3 in) clearance in 
depth to provide adequate venting.
Weight
 99 Kg (218 lbs)
Power input
 100, 120, 220, or 240 VAC at 4 A

50/60 Hz
Fuses
 Two power supply fuses: T4A, 250 VAC (Part# 2110- 1309)

One laser fuse: T500mA, 250 VAC (Part# 2110- 0458)
Temperature 
range
Operating: 15° to 30°C

Storage: - 20° to +50°C
Humidity
 Operating: 15% to 95% RH at 30°C

Potentially sensitive to condensing humidity conditions. Follow 
precautions stated in Chapter 5.
Altitude
 Operating maximum: 2,300 m (7,500 ft)

Storage maximum: 4,600 m (15,000 ft)
Usage
 Indoor use
Laser 
information
Excitation wavelengths: 

• SHG-YAG laser: 532 nm

• Helium- Neon (HeNe) laser: 633 nm

Power: 20 mW at 532 nm and 23 mW at 633 nm, both controlled 
to 13 mW
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Maximum scan 
region
Agilent G2565CA Microarray Scanne
Agilent G2565CA: 71 mm x 21.6 mm
Suggested 
microarray 

print region
1 mm smaller than scan region on the right, 2 mm on the left, 
and 0.6 mm on the top and bottom. For non- Agilent slides, the 
print region is smaller than this by an amount equal to the array 
printing tolerance.
Dyes supported
 Cyanine- 3 (Cy- 3) and cyanine- 5 (Cy- 5) and dyes similar to Cy- 3 
and Cy- 5 and Alexa 647, 555, and 660 dyes
Resolution 
(pixel size)
2, 3, 5 or 10 microns
Pixel placement 
error
< 1 pixel at 5- micron resolution
Uniformity
 5% CV global non- uniformity, average local non- uniformity is 
typically 1% based upon 100um features.
Scan time

Table 5 Scan Time for Single and Double Pass Scans for Agilent HD 

Scan Region 61 x 21.6 mm

Resolution Scan Time, 
min.

2 micron single pass 20

3 micron single pass 15

5 micron single pass 8

10 micron single pass 8

2 micron double pass 40

3 micron double pass 30

5 micron double pass 16
Dynamic range
 Single scan 16- bit dynamic range >104 

Single scan 20- bit dynamic range >105

Dual scan extended dynamic range (XDR) >106
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Scan dimensions
Slide specifications

Scan dimensions
98 Agilent G25
The scan region is specified in Figure 40. All dimensions are 
in millimeters and the reference point is the lower right side 
of the glass. 
Figure 40 Scan region for Agilent G2565CA

Glass specifications
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The microarray scanner uses slide holders to move the 
microarrays in and out of the carousel. These slide holders are 
designed to accept a 1 in  3 in nominal piece of glass. 

The detailed specifications of the glass are as follows:

• 1 inch wide (25.4 mm, - 0.45 mm, or +0.7 mm)

• 3 inches long (76.2 mm, +0.25 mm, or - 1.4 mm)

• 1 mm thick (+/- 0.1 mm) 

• No mirrored slides

• High quality with low intrinsic fluorescence

• Index of refraction from 1.510 to 1.515
65CA Microarray Scanner
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Barcode and barcode label specifications
Barcode and barcode label specifications
Agilent G2565CA Microarray Scanne
Barcode specifications for Agilent slides

The G2565CA scanner reads barcodes placed on the active side 
of the slide. 

For backwards compatibility with the G2565AA model 
scanners, Agilent microarrays continue to have barcodes on 
both sides. The label with the text “Agilent” denotes the active 
side; the label with the numeric value is the inactive side.

Figure 41 Agilent slide barcode orientation vs. microarray surface

Barcode specifications for non-Agilent slides

• The barcode label maximum thickness is 0.2 mm. Make sure 
there are no bubbles in the label. Do not add labels on top of 
old labels or replace labels that are beginning to peel off.

• Do not place barcode labels on slides whose scan region 
exceeds 61 mm. You must enter the slide identifier or 
barcode manually for slides whose scan regions exceed 61 
mm.
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Barcode and barcode label specifications
• For a barcoded slide, the distance between the edge of the 
microarray scan region and the edge of the barcode label can 
be no less than 4 mm.

Figure 42 Barcode location on non-Agilent slide

• The barcode label width should be about 6 mm; the 
recommended barcode label width is for use with the 61 mm 
scan region. Larger or longer barcode labels can be used by 
decreasing the scan region proportionally.

• Barcode labels should be narrow enough so as not to 
interfere with the slide holder tabs. 

• Maximum allowable tilt in the placement of the barcode label 
on the slide is ±3°.

The barcode must meet the following requirements: 

• The minimum quiet zone (the region between the edge of the 
label and the start or end of the barcode) is 10 times the 
X- dimension on each side of the barcode.

• Barcode lines must be parallel to the long edge of the slide 
within tilt tolerance of ±3°.

• Agilent supports the following barcode formats:

• Code 128: Non- Agilent barcodes with 12 digits must not 
start with 2

• CODABAR: Maximum of 8 digits; minimum line thickness 
= 6 mils

>4 mm
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Barcode and barcode label specifications

Agilent G2565CA Microarray Scanne
• Code 39: Maximum of 8 digits; minimum line thickness = 6 
mils

• Code 93: Maximum of 8 digits; minimum line thickness = 6 
mils

• Minimum height of barcode must be

• Code 128: 15% of barcode length for Code 128

• Code 39, Code 93, CODABAR: 5 mm or 15% of barcode 
length, whichever is greater
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Regulatory information
102 Agilent G25
This section lists regulatory information for the microarray 
scanner.

For research use only

The Agilent G2565CA Microarray Scanner is intended for 
RESEARCH USE ONLY. 

Acoustic noise information

Manufacturer’s Declaration:
English
 This statement is provided to comply with the requirements 
of the German Sound Emission Directive, from 18 January 
1991. Sound Pressure Lp < 70 dB(A), at operator’s position, 
normal operation, according to EN 27779 (Type Test).
Deutsch
 Die folgende Information wird in Übereinstimmung mit den 
Anforderungen der Maschinenlärminformationsverordnung 
vom 18. Januar 1991 erteilt. Schalldruckpegel am Arbeisplatz 
bei normalem Betrieb, Lp < 70 dB(A), nach EN 27779 
(Typprüfung).

Recycling and disposal
Contact Agilent Technologies for 
more information on recycling and 
disposal.
This device is designed to accommodate recycling at the end of 
its useful life. Please dispose of this device in accordance with 
local regulations. 

Electromagnetic interference

The scanner is intended for use with shielded cables only.
Emissions 
Complies with the emissions levels for Class A equipment as 
required in lEC 61326- 1. This equipment is not intended for use 
in residential areas. 
Immunity
 This device complies with the immunity levels required in IEC 
61326- 1 for a non- controlled, non- industrial environment. See 
accompanying Declaration of Conformity for specific levels. 
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Canada
Agilent G2565CA Microarray Scanne
This ISM (Industrial- Scientific- Medical) device complies with 
Canadian ICES- 001. 

Cet appareil ISM est conforme a la norme NMB- 001 du Canada.

Safety information

This scanner complies with the following safety standards:

CAN/CSA No. C22.2 
No. 1010.1 - 92

Safety Requirements for Electrical
Equipment for Measurement, Control, and 
Laboratory Use, Part 1: General Requirements 
(Includes Amendment 1)

CAN/CSA-C22.2 No. 
1010.1B-97 

Amendment 2 to CAN/CSA-C22.2 No.1010.1-92, 
Safety Requirements for Electrical Equipment for 
Measurement, Control, and Laboratory Use, 
Part 1: General Requirements

UL Std No. 3101.1 Electrical Equipment for Laboratory Use: 
Part 1: General Requirements

UL Std No. 3111-1 Equipment for Measurement Use; 
Part I: General Requirements

ISA S82.01-1994 Safety Standards for Electrical and Electronic 
Test, Measuring, Controlling, and Related 
Equipment - General Requirements

IEC 61010-1 Safety Requirements for Electrical Equipment for 
Measurement, Control, and Laboratory Use, 
Part 1: General Requirements

IEC 825-1 Safety of laser products Part 1: Equipment 
classification, requirements and user's guide.

EN60825-1

(Including Amendment 1:1992 and Amendment 2:1995)
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• Pollution Degree: 2

• Installation Category: II

• Class 1 Equipment; requires a grounding system

• Class 1 Laser Product

• UL/CSA Approved Product
65CA Microarray Scanner System (Scan Control Software 8.4) User Guide
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Input voltage check

Verify input voltage
Agilent G2565CA Microarray Scanne
Before turning on the microarray scanner for the first time or 
after it has been moved to another site, verify that the input 
voltage setting on the rear of the instrument is set to the correct 
value. The input voltage setting can be set to one of four values:

• 100 VAC

• 120 VAC

• 220 VAC

• 240 VAC

1 Go to the rear of the microarray scanner. 

2 View the input voltage setting through the small window.

Figure 43 Input voltage setting view window

3 If the input voltage setting matches the line voltage, you can 
safely turn on the microarray scanner.

If the input voltage setting does not match the line voltage, 
change the voltage setting.

Input voltage 
setting view 
window
r System (Scan Control Software 8.4) User Guide
 105



6 Reference
Change the voltage setting
Change the voltage setting
106 Agilent G25
1 Disconnect the power cord.
WARNING Always disconnect the power cord before changing the input voltage 
setting.
2 Use a small flat- edge screwdriver to pry up the small plastic 
tab located on the bottom edge of the fuse holder until it 
releases.
Fuse holder
Figure 44 Removing the fuse holder for the power supply

3 Pull out the fuse holder. 
65CA Micro
array Scanner System (Scan Control Software 8.4) User Guide
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Agilent G2565CA Microarray Scanne
4 Use needle nose pliers to remove the voltage selector.

Figure 45 Removing the voltage selector from the fuse holder

5 Insert the voltage selector so that the number showing 
matches the line voltage.

6 Push the fuse holder back in until it clicks into place.

7 Plug in the power cord.

Fuse holder

Voltage selector
r System (Scan Control Soft
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Change the voltage setting
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Index
A
aborting a scan, 41
Agilent slides

automatic barcode entry, 48
manual barcode entry, 48

air filter
cleaning, 70
inspecting, 69

archiving data, 33, 42, 68
automatic file naming, 56

B
barcode formats, 100
barcodes

automatic entry, 48
checking for, 49
manual entry, 48
non-Agilent, 21
specifications, 99

C
capturing diagnostic data, 83
carousel

checking for barcodes and empty 
slots, 49

covering, 30
inserting slides into, 24
loading slide holders into, 29
Report Log, 41
starting the run, 39
troubleshooting autoloader arm, 82

Carousel Report Log
definition, example of, 40
viewing during or after run, 41

carousel run, 32
cleaning air filter, 70
compressing TIFF, 57
computer hardware

system requirements, 12
Agilent G2565CA Microarray Scanne
computer system requirements, 12
create scan region, non-Agilent slides, 59

D
dark offset subtraction

description, 18
data

archiving, 42, 68
saving, 42

default scan settings, 55, 63
dye channel setting, 49
dynamic range

16-bit or 20-bit, 50
TIFF file, 50

E
empty slots, checking for, 49
error messages, 88

not appearing in table, 94
table in alphabetical order, 89
where and when they appear, 88

F
FAQs, 76

jammed slides, 77
opening the scanner lid, 76
program not responding, 76

FAQs (frequently asked questions), 76
features of system, 10
file naming, automatic, 56
fluorescence detection, 18
frequently asked questions (FAQs), 76
front view of scanner, 13
fuses

laser, 81
power supply, 80
r System (Scan Control Software 8.4)
G
glass slide, specifications, 98

H
high resolution scanning license, 20
humidity, 71

I
indicator lights, 13, 78, 79
initialization process, 23
input voltage

checking, 105
setting, 105

inspecting air filter, 69

L
laser excitation, 17
laser fuse, changing, 81
lasers

auto On/Off settings, 54
checking or replacing fuses, 81
turning off automatically, 35
turning on/off automatically, 63
turning on/off manually, 64
types used, 17

licensing
high resolution scanning, 20
non-Agilent barcode, 21

Log, Report, 41

M
maintenance tasks, 68 to 70
moving scanner, cautions, 72

N
naming files, automatic, 56
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Index
naming prefix 1 and 2, 56
network drive, 38, 51, 76
non-Agilent barcode licensing, 21
non-Agilent slides

creating scan region, 59

O
opening the scanner lid, 76
operating principles, 17
operating scanner, 22
output directory, selecting, 51
output path setting, 51

P
parts, list of, 11
power supply fuses, 80
preparation of site, 14
principles of operation, 17

dark offset subtraction, 18
fluorescence detection, 18
laser excitation, 17
scanning, 17
slide positioning, 17

profile
definition, 37, 44

Profile Editor, 54, 55
profile settings

compressing TIFF, 57
naming prefix 1 and 2, 56
not in scan table, 56
splitting/rotating image, 58

profiles, 54
changing settings, 45
creating, 56
editing, 55

R
rear view of scanner, 14
recovery CD, 87
recycling and disposal, 102
regulatory information

acoustic noise, 102
electromagnetic interference, 102
recycling and disposal, 102

removing scanner covers, 72
removing slides, 33
110 Agilent G25
Report Log, 41

S
safety

guidelines, 16
regulations, 103
symbols for scanner, 15

safety symbols, 15
scan dimensions, 98
Scan Progress dialog box, 39
scan region

area, 49
changing for non-Agilent slides, 61
creating for non-Agilent slides, 59
definition, 59

Scan Region Editor, 54, 59
creating new scan regions, 59, 60
editing existing scan regions, 61
starting, 59

scan regions, 54
creating, 60
editing, 61

scan report, 41
scan resolution, 49
scan settings

automatic file naming, 56
change, 44
changing in scan table, 38
split and rotate image, 58

scan slot, 39
scan table settings

changing, 44
changing individual, 46
changing through profiles, 45
dye channels, 49
output path, 51
red and green PMT gain, 51
resetting to current profile values, 47
scan region, 49
scan resolution, 49
sensitivity level (PMT), 51
slide description, 52
slide ID, 48
TIFF file dynamic range, 50
XDR ratio, 51

scan time, 40, 97
scan, definition, 32
65CA Microarray Scanner System (Sc
scanner
electromagnetic interference, 102
initializing, 22
maintenance tasks, 68 to 70
moving, 72
specifications, 96
stopping during scan, 41
turning on, 22
warning on removing covers, 72

scanner lid, opening, 76
scanning, 17
scanning slides, 32, 36

selecting a profile, 37
setting slot locations, 36
starting the carousel run, 39

scans
storage space and scan time table, 50

selecting a profile, 37
sensitivity level (PMT) setting, 51
serial number, scanner, 74, 75
setting slot locations, 36
signal-to-noise performance, 17
site preparation, 14
slide ID, 48
slide positioning, 17
slide specifications

glass slide, 98
scan dimensions, 98

slides
description for scanning, 52
inserting into carousel, 24
inserting into slide holders, 24
jammed, 77
removing, 33
scanning, 32
specifications, 98

software
icon, 22
main window, 23
maintenance, 68
not responding, 76
starting, 22
system requirements, 12

specifications, 15
barcodes, 99
Microarray Scanner, 96

split and rotate tiff image, 58
splitting/rotating image, 58
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Index
starting
software, 22

status indicator lights, 13, 78, 79
status, in Scan Progress dialog box, 39
stopping the scan, 41
support, technical, 74
system features, 10

T
technical support, 74

changing URL to reach, 74
technical support, calling, 74
temperature considerations, 71
TIFF file dynamic range, 50
tiff image, split and rotate, 58
top view of scanner, 13
transferring files, 42
troubleshooting

autoloader arm extended into 
carousel, 82

capturing diagnostic data, 83
error messages, 88 to 94
FAQs, 76
hardware, 78 to 81
replacing fuses, 80 to 81
technical support, 74
using recovery CD, 87
with status indicator lights, 78

V
version information, finding, 75
view report, 41
voltage check, 105
voltage setting, input, 105

X
XDR ratio, 51
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